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This chapter introduces At Ease 3.0. You can save time later if you take a few
minutes now to learn about At Ease and how you use it.

What is At Ease?

At Ease allows you to customize your computer for each person who uses it.
By providing a choice of working environments, At Ease lets you tailor the
computer’s interface for users of all ages and experience levels. In addition,
the wide range of security features in At Ease means that you can specify
each user’s access to information on the computer and prevent or allow
different levels of information control. Finally, At Ease offers every user the
privacy of his or her personal work space.

The person who controls users’ access is the At Ease owner. In a home setting,
the owner might be a parent; in a classroom or business setting, the owner
might be a teacher or office manager.

The At Ease owner can decide which application programs and documents
each user should have access to, where a user can open or save documents,
and which menu commands and Apple menu items are available to a user.
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For young or novice Macintosh users, the best working environment is the At
Ease panels—a simple, easy-to-use interface where documents and programs
are easily accessible. Like an application program, the At Ease panels run on
top of the Finder (the Macintosh desktop), but the user doesn’t see the Finder.
The owner controls access to documents and programs, and can set security
features restricting a user’s ability to save, delete, and copy items.

For older or more experienced Macintosh users, the restricted Finder may 
be the best working environment. Its interface is very similar to the usual
Macintosh desktop, but it lets the owner control access and set security
features.

Users who need complete, unrestricted access to everything on the computer
can use the regular Finder as their working environment.

You’ll learn more about the working environments that At Ease supports
when you register users in Chapter 3 of this manual.

About this book

This book is for the At Ease owner. Here’s what you’ll find in the remaining
chapters:

m Chapter 2 provides instructions for installing the At Ease 3.0 software on
your computer. (If you received At Ease with a Macintosh Performa
computer, the software has been installed for you, and you can skip
Chapter 2.) 

m Chapter 3 describes how to use the At Ease Setup program to set up At
Ease for your users.

m Chapter 4 discusses additional features of the At Ease Setup program.

m Chapter 5 provides tips and troubleshooting suggestions for getting the
most out of At Ease.

m Appendix A explains how to use the At Ease panels in your daily work.
You should share the information in this appendix with everyone who uses
the At Ease panels as his or her working environment.

m Appendix B outlines the special features of the restricted Finder. You
should share the information in this appendix with everyone who uses the
restricted Finder as his or her working environment.
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What you need to know before you begin

This book assumes that you have basic Macintosh skills. You should know
how to

m use the mouse and keyboard

m choose commands from menus

m open folders and application programs

m save documents

If you need to learn more about these basic tasks, consult the learning
materials that came with your computer.

Other sources of information

In addition to this book, you can take advantage of the on-screen instruction
built into At Ease—Balloon Help and (if you are using system software
version 7.5 or later) Apple Guide instructions for both At Ease Setup and 
At Ease itself.

When Balloon Help for At Ease is turned on, users of the At Ease panels can
get information about any item on the screen simply by pointing to the item
with the mouse. See “Using Balloon Help” in the “Getting Help” section of
Appendix A.

With At Ease Setup Guide—available in the Guide (h) menu whenever 
At Ease Setup is the active program—you can get step-by-step instructions
for using the At Ease Setup program. See “Getting On-Screen Instructions for
At Ease Setup” in Chapter 3.

With At Ease Guide—available in the Guide (h) menu whenever At Ease 
is the active program—users can get step-by-step instructions for using the 
At Ease panels. See “Using At Ease Guide” in the “Getting Help” section of
Appendix A.

You should check to see if there is any late-breaking news about At Ease 
that is not included in this book. If you have the At Ease Install disk, open the
At Ease 3.0 Read Me file to find additional information. If you don’t have this
disk, open the At Ease 3.0 Read Me file on your hard disk. This file also
includes information on the new features of version 3.0 of At Ease.
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Before you can set up At Ease and begin using it, you need to install the
software.

IMPORTANT  If you received At Ease packaged with a Macintosh Performa
computer, you can skip this chapter. (The At Ease software is already
installed on your computer.) Continue with Chapter 3. 

Restrictions on copying At Ease

As a licensed user of At Ease, you may use the software on a single
Macintosh computer and make one copy for backup purposes. However, you
are not permitted to distribute additional copies of the software. (For more
details, see the software license agreement that came with At Ease.)

What do you need to run At Ease?

Your computer must have the following features to run At Ease 3.0:

m at least 4 megabytes (MB) of random-access memory (RAM) (5 MB if you
want to use the Mouse Practice program)

m system software version 7.0 or later

m an internal or external hard disk 

m a high-density (1.4 MB) floppy disk drive for the installation process
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Installing At Ease

To install At Ease on your hard disk, you use the Installer program on the 
At Ease Install disk included in the At Ease package.

Make sure you have the At Ease Install disk ready.

1 Turn on your Macintosh and wait until the Macintosh desktop appears.

2 Insert the At Ease Install disk.

You should now see a window that looks like this:

3 Double-click the Installer icon.

A screen appears, welcoming you to the At Ease Installer.

Insert the floppy disk, metal

end first, into the floppy disk

drive of your computer.
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4 Click the Continue button.

After a few moments, the Installer shows you this screen:

Make sure that the disk named is your startup disk (the disk with system
software on it that you use to start up your computer; the startup disk’s icon
should be in the upper-right corner of your screen). If not, click Switch Disk
until you see the name of your startup disk.

If you have limited hard disk space, you may need to use the Custom Install
option. Choose Custom Install from the pop-up menu and select only those
items you wish to install from the list that appears. (The only item you must
select is At Ease Software.) To see information about a particular item, click
the box marked with the letter i to the right of the item.

5 Click the Install button.

If any application programs are running, the Installer prompts you to quit
those programs.

A status screen shows you the progress of the installation. When the
installation is complete, you see this message:

6 Click Restart to exit from the Installer program and restart the computer.
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Installing Mouse Practice

If you purchased At Ease as a software package, you also received a program
called Mouse Practice. This program provides easy, step-by-step instructions
for using the mouse. If any first-time users will be using your computer, you
may want to install Mouse Practice.

If you received At Ease with a Macintosh Performa computer, you did not
receive the Mouse Practice program. First-time users can learn mouse skills
from the Performa Tutorial, available in the Launcher. (To use the Performa
Tutorial, users must be in the Finder.)

To install the Mouse Practice program, follow these steps:

1 Insert the Mouse Practice Install disk.

You should now see a window that looks like this:

WARNING  Before a user opens the Mouse Practice program, make sure
virtual memory is turned off in the Memory control panel.
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2 Double-click the Installer icon.

After a few moments, the Installer shows you this screen:

Make sure that the disk named is your startup disk (the disk with system
software on it that you use to start up your computer; the startup disk’s icon
should be in the upper-right corner of your screen). If not, click Switch Disk
until you see the name of your startup disk.

3 Click the Install button.

A status screen shows you the progress of the installation. When the process
is complete, you see a message confirming that installation was successful.

4 Click Quit to leave the Installer program.

You’re now ready to set up At Ease exactly as you want it. Turn to 
Chapter 3 for instructions.
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This chapter describes the basic procedures to set up At Ease for your
computer’s users:

m opening the At Ease Setup program

m setting an administrator password

m registering yourself as the At Ease owner

m registering other users 

m duplicating the privileges of an existing user

m removing users

m making changes to a user’s access privileges

m turning At Ease on
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Opening the At Ease Setup program

You use the At Ease Setup program to prepare your computer for use with At
Ease. Follow these steps to open the program:

1 Double-click the At Ease Setup Folder icon in the hard disk window to open the folder.

Your window may not look exactly the same as the one shown here.

2 Double-click the At Ease Setup icon to start the program.

A Welcome screen appears.

3 Click the OK button.

The At Ease Setup window appears.
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Getting on-screen instructions for At Ease Setup

If you prefer, you can use on-screen instructions instead of—or in addition
to—the instructions in the rest of this chapter. The instructions available
depend on which version of system software you are using.

On-screen instructions with system software version 7.0 or 7.1

If you are using system software version 7.0 or 7.1, the following button and
text appear on each panel in the At Ease Setup program. 

To get on-screen instructions, follow these steps:

1 Click the button with the question mark icon.

An At Ease Setup Help window appears.

2 Read the information in the Help window.

3 If there is a button labeled Next, click it to see an additional Help panel.

To return to a panel you’ve already seen, click the button labeled Previous.

4 When you have finished reviewing the information in the Help window, click Done.
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On-screen instructions with system software version 7.5 or later

If you are using system software version 7.5 or later, step-by-step on-screen
instructions for using the At Ease Setup program are available through a
feature called Apple Guide. The following text appears on the opening screen
of the the At Ease Setup program:

1 Pull down the Guide menu (marked with the h icon near the right end of the menu bar)
and choose At Ease Setup Guide.

The At Ease Setup Guide access window appears.

Whenever you use At Ease Setup Guide, its window—either this access
window or a panel displaying instructions—remains in front of other
windows. If the window gets in your way, you can move it by dragging its
title bar (the gray bar across the top of the window). Instruction panels also
have a zoom box in the upper-right corner that lets you quickly reduce the
size of the panel.
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2 Notice the three buttons at the top of the window: Topics, Index, and Look For.

At Ease Setup Guide gives you three ways of finding information:

m Topics  lets you choose from a list of general subjects; it is like the table of
contents in a book.

m Index  lets you choose from an alphabetical list of more specific subjects; it
is like the index in a book.

m Look For  lets you search for information related to a specific word or
phrase that you type.

Getting information with the Topics button
If you prefer to find information by topic, follow these steps:

1 In the At Ease Setup Guide access window, click the Topics button.

A list of general topics appears on the left side of the window.

2 Click the desired topic area in the list of topics.

When you click any topic area, a list of related questions appears on the right
side of the At Ease Setup Guide access window.

3 Click the desired phrase or question in the list on the right, and then click OK. (Or
double-click the phrase or question.)

A small window appears with information or instructions. If the information
requires more than one panel, the right arrow in the lower-right corner is
active. You can click this arrow to move to the next panel of the instructions.

4 When you have finished reading the information or following the instructions on all the
panels in the sequence, click the Topics button in the lower-left corner to return to the At
Ease Setup Guide access window. Or, if you are finished using At Ease Setup Guide,
click the close box in the upper-left corner to close At Ease Setup Guide.
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Getting information with the Index button
If you prefer to find information by index term, follow these steps:

1 In the At Ease Setup Guide access window, click the Index button.

An alphabetical list of subjects appears on the left side of the window.

2 If necessary, scroll through the alphabetical list until the desired subject appears.

You can scroll through the list either by dragging the slider to the desired
letter or by using the scroll bar at the right of the list.

3 Click the desired subject in the alphabetical list.

When you click any index entry, a list of related questions appears on the
right side of the At Ease Setup Guide access window.

4 Click the desired phrase or question in the list on the right, and then click OK. (Or
double-click the phrase or question.)

A small window appears with information or instructions. If the information
requires more than one panel, the right arrow in the lower-right corner is
active. You can click this arrow to move to the next panel of the instructions.

5 When you have finished reading the information or following the instructions on all the
panels in the sequence, click the Topics button in the lower-left corner to return to the At
Ease Setup Guide access window. Or, if you are finished using At Ease Setup Guide,
click the close box in the upper-left corner to close At Ease Setup Guide.

Getting information with the Look For button

If you prefer to find information by searching for a specific word or phrase,
follow these steps:

1 In the At Ease Setup Guide access window, click the Look For button.

A small box appears on the left side of the window, where you can type text.

2 Click the arrow button to the left of the text box (or click inside the text box) to activate
the box.
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3 Type the desired word or phrase in the text box and then click Search.

When you click Search, a list of questions related to the word or phrase you
typed appears on the right side of the At Ease Setup Guide access window.

If At Ease Setup Guide is unable to locate any information on the word or
phrase you typed, you’ll see a message to that effect on the right side of the
access window. Try typing a different word or phrase.

4 Click the desired phrase or question in the list on the right, and then click OK. (Or
double-click the phrase or question.)

A small window appears with information or instructions. If the information
requires more than one panel, the right arrow in the lower-right corner is
active. You can click this arrow to move to the next panel of the instructions.

5 When you have finished reading the information or following the instructions on all the
panels in the sequence, click the Topics button in the lower-left corner to return to the At
Ease Setup Guide access window. Or, if you are finished using At Ease Setup Guide,
click the close box in the upper-left corner to close At Ease Setup Guide.

Setting an administrator password

To prevent other users from changing access privileges, the At Ease owner
needs to set an administrator password. Only users who know this password
will be able to change access privileges in the At Ease Setup program.

IMPORTANT  If you do not set an administrator password, every user will have
access to the At Ease Setup program and can change access privileges for 
any user (including the owner).

1 Choose Change Password from the Options menu.
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The Change Password screen appears.

2 Type an administrator password in the box labeled “Enter new password.”

You can type up to 31 characters. As you type, dots (•••) appear in place of
the text so that anyone nearby will be unable to see what password you have
typed. Be sure to choose a password that only you would know. 

3 Retype the administrator password in the box labeled “Reenter new password” to
confirm it.

4 If you wish, click inside the box labeled “Clue” and type a clue that will help you
remember your password.

The clue will appear each time you are asked to provide the administrator
password. As with the password itself, be sure to choose a clue that only you
will recognize.

5 Click OK.

In the future, you will need to provide the administrator password before you
can use the At Ease Setup program. You can change the password at any time,
by following the same steps as when you set the password—but only after
entering the original password.

If you’ve forgotten the password, see “If You Forget the Administrator
Password” in Chapter 5.
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Registering yourself as the At Ease owner

Before you register other users, you should register yourself as the At Ease
owner—that is, the person who controls other users’ access on the computer.
Follow these steps:

1 Click the New button in the At Ease Setup screen.

The New User screen appears.

2 Type your name in the upper box.

3 Click in the lower box and type a password for yourself.

Each time you start up the computer, you will be required to provide this
password as part of the log-in process. (You can also use the administrator
password to log in as yourself or any other user.)
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4 Click the “switch to regular Finder” button.

Note that the Next button changes to a Done button.

5 Click the Done button.

You return to the At Ease Setup screen. Your name appears in the list 
of users.

Registering other users

Everyone else who will use your computer must be registered in the At Ease
Setup program. At Ease allows you to register up to 40 users (including the
owner) with different access privileges. Unless they know someone else’s
password, unregistered users will not be able to proceed past the At Ease
Welcome screen when starting up the computer.

The steps you follow to register a user depend on what working environment
you want to assign the user:

m At Ease panels  Users who start up with the At Ease panels see a simple,
easy-to-use interface where programs and documents are easily accessible.
As the At Ease owner, you can limit an At Ease user’s access to programs
and documents, menu commands, locations for opening and saving, and
more. At Ease is a particularly good working environment for novice or
young Macintosh users. For a complete description of the At Ease panels
interface, see Appendix A.

m Restricted Finder  Users who start up with the restricted Finder see an
interface that looks much like the traditional Finder (or Macintosh
desktop). But unlike the regular Finder, the restricted Finder option lets the
At Ease owner limit the user’s access in many of the same ways as the At
Ease panels. The restricted Finder is a good working environment for more
experienced Macintosh users whose access you want to control. For a
description of the restricted Finder interface, see Appendix B.

m Regular Finder  Users who start up with the regular Finder see the traditional
Macintosh desktop. They have free access to all the documents and
programs stored on the computer’s hard disk. The regular Finder is an
appropriate working environment for yourself (as the At Ease owner) 
and any other users who should have unlimited access to the computer’s
contents.
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For each user, decide which working environment is appropriate and follow
the complete sequence of steps in the corresponding section below. 

Registering an At Ease user

To register a user who will start up with the At Ease panels, follow these
steps:

1 Click the New button in the At Ease Setup screen.

Page 1 of the user setup pages appears. This is where you specify the user’s
name, password, and working environment.

2 Type the user’s name in the upper box.
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3 If you want to give this user a password, click in the lower box and type the password.

A password provides privacy for the user. Other At Ease users and restricted
Finder users can’t access documents that the user saves in his or her personal
folder without providing the password. (As the At Ease owner, you—along
with any other user who starts up with the regular Finder—have access to
everything on the computer.) Passwords are generally unnecessary for young
children, who probably don’t need privacy on the computer and may not
understand the concept of passwords.

If you assign a password for this user, he or she will be required to provide it
each time he or she logs in. Be sure to make a note of the password so that
you can inform the user of it. 

Users can change their passwords whenever they like. But you can always log
in as any user by providing the administrator password.
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4 Click the Next button.

Page 2 of the user setup pages appears. This is where you specify the
application programs and other items this user can have access to.

5 Click the Add Applications button.

At Ease searches your startup disk for all application programs. After a few
moments, the Add Applications screen appears, listing all the programs that
were found in the list on the left. (If you have a very large hard disk, it may
take a while for the Add Applications screen to appear.)

Note:  Apple II programs do not appear in this list. To add Apple II programs,
you must use the Find Items command, explained in steps 11–16 of these
instructions.
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6 Select any programs that you want the user to have access to.

If you purchased At Ease as a software package, it came with a program
called Mouse Practice. If the user hasn’t had experience using the mouse, 
be sure to include Mouse Practice among the items you select.

To select more than one item in the list, hold down the Shift key while you
click the names of the items.

7 Click Add.

The selected items move from the list on the left into the “Items for this
User” list on the right.

As a shortcut, you can double-click programs or drag them from the list on
the left to the list on the right.

8 If you want to give the user access to programs on another disk, use the Disk pop-up
menu to view its contents. (If not, skip to step 10.)

To search a floppy disk other than the one currently in a floppy drive, select
the current floppy disk in the Disk pop-up menu and click the Eject button.
Then insert the floppy disk you want to search.
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If you give the user access to programs on a CD-ROM disc or a floppy disk,
the disk must be present in a drive in order for the user to open and use those
programs. For programs on a CD-ROM disc, the disc must also be available 
to users in the CD-ROM Preferences screen. (See “Customizing Access to
CD-ROM Discs” in Chapter 4 for more information.) For programs on a
floppy disk, the user must also have access privileges to open and save on
floppy disks, as described in steps 23 and 24 of this section.

9 Select the desired programs and click the Add button.

10 When you have finished adding programs, click OK.

You return to page 2 of the user setup pages. The programs you added now
appear in the “Items for this User” list. (If you later decide to remove a
program, select it in this list and click the Remove button.)
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11 If you want to give the user access to any other items—for example, documents,
individual control panels, or Apple menu items such as the Calculator—click the Find
Items button. (If not, skip to step 16.)

Note:  You can also use the Find Items screen to give users access to shared
disks or file servers. For instructions, see “Giving Users Access to Shared
Disks” in Chapter 4.

12 Type part or all of the item name in the upper box.

Typing part of the name can be a useful shortcut. However, if you type too
short a selection, you may find more items than you want. For example,
typing “car” would find all of the following items: “car,” “carnation,” “car
repairs,” “day care,” and “scarf.”

13 If necessary, use the Disk pop-up menu to indicate which disk you want to search.

To search a floppy disk other than the one currently in a floppy drive, select
the current floppy disk in the Disk pop-up menu and click the Eject button.
Then insert the floppy disk you want to search.

If you give the user access to items on a CD-ROM disc or a floppy disk, the
disk must be present in a drive in order for the user to open and use those
items. For items on a CD-ROM disc, the disc must also be available to users
in the CD-ROM Preferences screen. (See “Customizing Access to CD-ROM
Discs” in Chapter 4 for more information.) For programs on a floppy disk, the
user must also have access privileges to open and save on floppy disks, as
described in steps 23 and 24 of this section.
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14 Click the Find button.

A list appears on the left, showing all items on the selected disk whose names
contain the text you typed.

15 Select the desired items and click the Add button.

To select more than one item in the list, hold down the Shift key while you
click the names of the items.

As a shortcut, you can double-click items or drag them from the list on the
left to the list on the right.

16 When you have finished adding items, click OK.

You return to page 2 of the user setup pages. The items you added now
appear in the “Items for this User” list. (If you later decide to remove an item,
select it in this list and click the Remove button.)

17 Click the Next button.

Page 3 of the user setup pages appears. This is where you can specify 
which menu commands the user will see. (For more information about 
the commands available in the At Ease menus, see “At Ease Menus” in 
Appendix A.)
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18 If you want to limit user access to basic menu commands, click the Minimal button to
select it.

This option restricts the user to such basic menu commands as Close, Quit,
Restart, and Shut Down. The user cannot rename or delete files, create new
folders, or access the Chooser or the Control Panels folder in the Apple menu.

19 If you want to give the user somewhat more access to menu commands, leave the
Restricted button selected.

This option adds access to the Get Info command, the Find command, and
the Chooser desk accessory to the Minimal menu command set, but the user
still does not have access to commands for renaming or deleting files or
creating new folders.

20 If you want to give the user access to the most possible menu commands, click the All
button.

This option allows the user to perform a wider variety of file-management
tasks, including renaming and deleting his or her own files, creating new
folders, and changing the view of items on the At Ease screen.

Certain menu commands may be unavailable even when the All menu option
is selected. For example, users who don’t have access privileges to open and
save items on floppy disks won’t see the Copy To Floppy and Copy From
Floppy commands.
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21 If you want to activate the spoken button names feature of At Ease, click the checkbox
labeled “Speak button names.”

At Ease gives you the option of having the computer speak the name of each
button as the pointer passes over it on the screen. (This feature can be useful
for children who have not yet learned to read or for people with visual
disabilities.)

If you have attached a sound to an At Ease button (as described in “Adding
and Removing Button Sounds” in Chapter 4), the computer will play the
sound instead of speaking the name of the button.

IMPORTANT  Before you use the spoken button names feature, you should turn
off virtual memory in the Memory control panel.
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22 Click the Next button.

Page 4 of the user setup pages appears. This is where you can set security
features for this user.

23 If you want the user to be able to open and save files in any folder on any disk, click the
Anywhere button. Then skip to step 25.

This option gives the user the greatest freedom of file management, but it
limits the owner’s control over the arrangement of items on the computer’s
disks and also limits the privacy of other users.

When a user with this option chooses Save or Save As in a program, the
dialog box that appears suggests the user’s folder as the save location—but the
user can use the dialog box to choose any location.

24 If you want to limit where the user can open and save items, leave the Only button
selected, then use the checkboxes to specify a location or locations.

m To allow the user to open and save both in the user’s folder and on floppy
disks, make sure both checkboxes are selected.

m To allow the user to open and save only on a floppy disk, select the “on a
floppy disk” checkbox and deselect the “in the user’s folder” checkbox.

m To allow the user to open and save only in the user’s folder, deselect the “on
a floppy disk” checkbox and select the “in the user’s folder” checkbox.

m To prevent the user from opening or saving anywhere, make sure neither
checkbox is selected.
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25 If you want the user to be able to make screen captures, click the “Allow the user to
make screen captures” checkbox to select it; if not, leave it deselected.

Macintosh system software includes a screen-capturing feature that lets you
take a “snapshot” of what’s currently on the screen by holding down the
Command (x) and Shift keys while you type the number 3. If the “Allow the
user to make screen captures” checkbox is selected, this user will have access
to this feature.

Note: Screen captures are automatically stored in the user’s folder. If this user
does not have the privileges to open and save items in the user’s folder, the
screen-capturing feature is not available and the checkbox will be dimmed.
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26 If you want to give the user access to the regular Finder, click the “Allow the user
unrestricted access to the Finder” checkbox; if not, leave it deselected.

To give users even more freedom of file management, you can allow them
unrestricted access to the regular Finder (the Macintosh desktop).When you
select this option for a user, he or she will have access to all the documents
and programs stored on the computer’s hard disks. For that reason, you should
consider carefully which users (if any) should be given this option.

Activating this option is different from setting the regular Finder as the user’s
working environment. In this case, the user will start up with the At Ease
panels but can switch to the regular Finder using a menu command in the
Special menu. (A password is not required for the user to switch to the regular
Finder.)

27 Click the Done button.

You are now finished registering this user. If you want to change this user’s
access privileges in the future, you can always return to At Ease Setup and
make any needed changes. (See “Making Changes to a User’s Access
Privileges” later in this chapter for instructions.)

If you have additional users to register, return to “Registering Other Users”
earlier in this chapter and follow the appropriate set of instructions for the
next user.
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Registering a restricted Finder user

To register a user who will start up with the restricted Finder, follow these
steps:

1 Click the New button in the At Ease Setup screen.

Page 1 of the user setup pages appears. This is where you specify the user’s
name, password, and working environment.

2 Type the user’s name in the upper box.
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name here.



3 If you wish to give this user a password, click in the lower box and type the password.

A password provides privacy for the user. Other restricted Finder users and At
Ease users can’t access documents that the user saves in his or her personal
folder without providing the password. (As the At Ease owner, you—along
with any other user who starts up with the regular Finder—have access to
everything on the computer.) Passwords are generally unnecessary for young
children, who probably don’t need privacy on the computer and may not
understand the concept of passwords.

If you assign a password for this user, he or she will be required to provide it
each time he or she logs in. Be sure to make a note of the password so that
you can inform the user of it. 

Users can change their passwords whenever they like. But you can always log
in as any user by providing the administrator password.

4 Click the “switch to restricted Finder” button.
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5 Click the Next button.

Page 2 of the user setup pages appears. This is where you specify the
application programs and other items this user can have access to.

6 Click the Add Applications button.

At Ease searches your startup disk for all application programs. After a few
moments, the Add Applications screen appears, listing all the programs that
were found in the list on the left. (If you have a very large hard disk, it may
take a while for the Add Applications screen to appear.)

Note:  Apple II programs do not appear in this list. To add Apple II programs
you must use the Find Items command, explained in steps 12–17 of these
instructions.
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7 Select any programs that you want the user to have access to.

If you purchased At Ease as a software package, it came with a program
called Mouse Practice. If the user hasn’t had experience using the mouse, 
be sure to include Mouse Practice among the items you select. 

To select more than one item in the list, hold down the Shift key while you
click the names of the items.

8 Click Add.

The selected items move from the list on the left into the “Items for this
User” list on the right.

As a shortcut, you can double-click programs or drag them from the list on
the left to the list on the right.
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9 If you want to give the user access to programs on another disk, use the Disk  pop-up
menu to view its contents. (If not, skip to step 11.)

If you want to search a floppy disk other than the one currently in a floppy
drive, select the current floppy disk in the Disk pop-up menu and click the
Eject button. Then insert the floppy disk you want to search.

If you give the user access to programs on a CD-ROM disc or a floppy disk,
the disk must be present in a drive in order for the user to open and use those
programs. For programs on a CD-ROM disc, the disc must also be available 
to users in the CD-ROM Preferences screen. (See “Customizing Access to
CD-ROM Discs” in Chapter 4 for more information.) For programs on a
floppy disk, the user must also have access privileges to open and save on
floppy disks, as described in steps 23 and 24 of this section.

10 Select the desired programs and click the Add button.

11 When you have finished adding programs, click OK.

You return to page 2 of the user setup pages. The programs you added now
appear in the “Items for this User” list. (If you later decide to remove a
program, select it in this list and click the Remove button.)
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12 If you want to give the user access to any other items—for example, documents,
individual control panels, or Apple menu items such as the Calculator—click the Find
Items button. (If not, skip to step 17.)

Note:  You can also use the Find Items screen to give users access to shared
disks or file servers. For instructions, see “Giving Users Access to Shared
Disks” in Chapter 4.

13 Type part or all of the item name in the upper box.

Typing part of the name can be a useful shortcut. However, if you type too
short a selection, you may find more items than you want. For example,
typing “car” would find all of the following items: “car,” “carnation,” “car
repairs,” “day care,” and “scarf.”

14 If necessary, use the Disk pop-up menu to indicate which disk you want to search.

If you want to search a floppy disk other than the one currently in a floppy
drive, select the current floppy disk in the Disk pop-up menu and click the
Eject button. Then insert the floppy disk you want to search.

If you give the user access to items on a CD-ROM disc or a floppy disk, the
disk must be present in a drive in order for the user to open and use those
items. For items on a CD-ROM disc, the disc must also be available to users
in the CD-ROM Preferences screen. (See “Customizing Access to CD-ROM
Discs” in Chapter 4 for more information.) For programs on a floppy disk, the
user must also have access privileges to open and save on floppy disks, as
described in steps 23 and 24 of this section.
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15 Click the Find button.

A list appears on the left, showing all items on the selected disk whose names
contain the text you typed.

16 Select the desired items and click the Add button.

To select more than one item in the list, hold down the Shift key while you
click the names of the items.

As a shortcut, you can double-click items or drag them from the list on the
left to the list on the right.

17 When you have finished adding items, click OK.

You return to page 2 of the user setup pages. The items you added now
appear in the “Items for this User” list. (If you later decide to remove an item,
select it in this list and click the Remove button.)

18 Click the Next button.

Page 3 of the user setup pages appears. This is where you specify which
Apple menu items the user will see. (You can select all, none, or any
combination of options.)
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19 If you want the user to be able to use the Chooser to select printers and other devices,
leave the Chooser checkbox selected; if not, click the checkbox to deselect it.

20 If you want the user to be able to open control panels and make changes to the way the
computer is customized, click the Control Panels checkbox to select it; if not, leave the
checkbox deselected.

Even if you don’t select the Control Panels checkbox, you can give the user
access to individual control panels using the Find Items dialog box, described
in steps 12–17 of these instructions. 

21 If you want the user to have access to all other Apple menu items, leave the Other Apple
Menu Items checkbox selected; if not, click the checkbox to deselect it.

22 Click the Next button.

Page 4 of the user setup pages appears. This is where you can set security
features for this user.

23 If you want the user to be able to open and save files in any folder on any disk, click the
Anywhere button. Then skip to step 25.

This option gives the user the greatest freedom of file management, but it
limits the administrator’s control over the arrangement of items on the
computer’s disks and also limits the privacy of other users.
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24 If you want to limit where the user can open and save items, leave the Only button
selected, then use the checkboxes to specify a location or locations:

m To allow the user to open and save both in the user’s folder and on floppy
disks, make sure both checkboxes are selected.

m To allow the user to open and save only on a floppy disk, select the “on a
floppy disk” checkbox and deselect the “in the user’s folder” checkbox.

m To allow the user to open and save only in the user’s folder, deselect the “on
a floppy disk” checkbox and select the “in the user’s folder” checkbox.

m To prevent the user from opening or saving anywhere, make sure neither
checkbox is selected.

25 If you want the user to be able to make screen captures, click the “Allow the user to
make screen captures” checkbox to select it; if not, leave it deselected.

Macintosh system software includes a screen-capturing feature that lets you
take a “snapshot” of what’s currently on the screen by holding down the
Command (x) and Shift keys while you type the number 3. If the “Allow the
user to make screen captures” checkbox is selected, this user will have access
to this feature.

Note: Screen captures are automatically stored in the user’s folder. If this user
does not have the privileges to open and save items in the user’s folder, the
screen-capturing feature is not available and the checkbox will be dimmed.

When this checkbox
is selected, the user

can make screen
captures.



26 Click the Done button.

You are now finished registering this user. If you want to change this user’s
access privileges in the future, you can always return to At Ease Setup and
make any needed changes. (See “Making Changes to a User’s Access
Privileges” later in this chapter for instructions.)

If you have additional users to register, return to “Registering Other Users”
earlier in this chapter and follow the appropriate set of instructions for the
next user.

Registering a regular Finder user

To register a user who will start up with the regular Finder, follow these steps:

1 Click the New button in the At Ease Setup screen.

Page 1 of the user setup pages appears. This is where you specify the user’s
name, password, and working environment.
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2 Type the user’s name in the upper box.

3 If you wish to give this user a password, click in the lower box and type the password.

It’s a good idea to assign a password to each regular Finder user. If you don’t,
At Ease users and restricted Finder users can log in as a regular Finder user
and have access to everything on the computer.

If you assign a password for this user, he or she will be required to provide it
each time he or she logs in. Be sure to make a note of the password so that
you can inform the user of it. 

Users can change their passwords whenever they like. But you can always log
in as any user by providing the administrator password.
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4 Click the “switch to regular Finder” button.

Note that the Next button changes to a Done button.

5 Click the Done button.

You are now finished registering this user. If you want to change this user’s
access privileges in the future, you can always return to At Ease Setup and
make any needed changes. (See “Making Changes to a User’s Access
Privileges” later in this chapter for instructions.)

If you have additional users to register, return to “Registering Other Users”
earlier in this chapter and follow the appropriate set of instructions for the
next user.
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Duplicating an existing user’s privileges

If you want to register a new user with exactly the same access privileges as
an existing user, you can take advantage of a shortcut in the At Ease Setup
program. Follow these steps:

1 In the At Ease Setup screen, click the name of the user whose access privileges you
want to duplicate for the new user.

2 Click the Duplicate button.

The Duplicate User screen appears.

3 Type the name of the new user and click OK.

You are now finished registering this user. He or she will have exactly the
same access privileges (including the password) as the user you duplicated. If
you wish, you can change the password and other access privileges. (See
“Making Changes to a User’s Access Privileges” later in this chapter for
instructions.)

45Set t ing Up At  Ease for  Users

…then click the 
Duplicate button.

Click the name of the
user whose access
privileges you want 

to duplicate for 
the new user…



Removing users

If you decide to remove one or more users, follow the steps in this section.

1 Open the At Ease Setup program and type the administrator password.

2 Select the name of each user you want to remove.

3 Click the Remove button.

Removed users will no longer be able to proceed past the At Ease Welcome
screen.

Making changes to a user’s access privileges

If you decide that you want to change a user’s access privileges, follow 
these steps:

1 Open the At Ease Setup program and type the administrator password.

2 Click the name of the user whose access privileges you want to change.

3 Click Open.

4 Follow the instructions in the appropriate section of this chapter to make whatever
changes you wish to the user’s access privileges.

The changes will be effect the next time any user logs in.

5 Repeat steps 2–4 for each user whose privileges you want to change.

WARNING  When you remove a user, At Ease Setup also removes the
user’s folder and everything in it. If you don’t want to lose the contents
of the user’s folder, make a backup copy or move the contents to another
location before following these steps.
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Turning At Ease on

When you first install At Ease, it is turned off. (This is also the case for
Macintosh Performa computers.) To turn At Ease on, do this:

m In the At Ease Setup screen, click the On button.

The next time you restart the computer, At Ease will be on and you will see
the At Ease Welcome screen. (See “Starting Up With At Ease” in Appendix A
for details.)

Quitting the At Ease Setup program

When you have registered all of your users and turned At Ease on, choose
Quit from the File menu. You return to the Macintosh desktop.

Where to go from here

To learn about additional features you can control with the At Ease Setup
program, turn to Chapter 4.

To learn how to use the At Ease panels, turn to Appendix A.

To learn how to use the restricted Finder, turn to Appendix B.
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This chapter describes advanced features of At Ease Setup that let you further
control users’ access to items and customize the computer for users. You’ll
also find instructions for turning At Ease off and removing At Ease
permanently.

Customizing access to CD-ROM discs

If you have a CD-ROM drive connected to your computer, you may want to
customize users’ access to CD-ROM discs. You can give users access to all
available CD-ROM discs, or restrict access to selected discs (and even
selected items on a disc).

You customize access to CD-ROM discs using the CD-ROM Preferences
command, available in the Settings menu. Settings you make using this
command apply to all At Ease and restricted Finder users. (To limit a
particular user’s access, you must use the Add Applications and Find Items
screens during the registration process, as described in Chapter 3.)

Users who start up with the regular Finder will have access to all available
CD-ROM discs, regardless of the settings you make here.

To customize access to CD-ROM discs, follow these steps:

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.
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2 Choose CD-ROM Preferences from the Settings menu.

The CD-ROM Preferences screen appears.

3 If you want all At Ease and restricted Finder users to have access to all available CD-
ROM discs, make sure the button labeled “Allow access to all CD-ROMs” is selected.
Then skip to step 10.

4 If you want to limit which CD-ROM discs users will have access to, click the button
labeled “Only allow access to the specified CD-ROMs.”

5 Click the Add button.

The Add New CD-ROM screen appears, listing all CD-ROM discs currently
available in CD-ROM drives connected to the computer.

50 Chapter  4

Click this button if you
want to limit users’

access to CD-ROM
discs.

Click this button if you
want all users to have
access to all available

CD-ROM discs.



6 To give access to a CD-ROM disc, select the disc name and click OK.

If the disc you want is not currently available, you can select another disc in
the list and click the Eject button to eject it. Then insert the desired disc in
the CD-ROM drive.

When you select a disc and click OK, you return to the CD-ROM Preferences
screen, and the disc you selected now appears in the list of available discs.

7 If you want to limit users’ access to particular items on a CD-ROM disc, select the disc
name and click Settings. Otherwise, skip to step 10.

A Settings screen for the selected disc appears.

8 Use the checkboxes to specify which items users will have access to. (Only items whose
checkboxes are selected will be available to users.)

As a shortcut to select or deselect all items at once, use the Select All or
Select None buttons.

9 Click the OK button in the Settings screen for the disc.

10 Click the OK button in the CD-ROM Preferences screen.
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Giving all users access to an item at the same time

If there are items you want all At Ease and restricted Finder users to have
access to, you can take advantage of a shortcut in At Ease Setup to add items
to all users at once. Follow these steps:

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Choose Add Item To All Users from the Options menu.

The Add File screen appears.

3 In the list of items that appears, select the item you want to give all users access to.

If the item you want is located on another disk, make sure that Desktop is
selected in the pop-up menu; then select the disk in the list of items and 
click Open.

If the item is located in a folder, select the folder and click Open.

4 Click the Add button.

A message appears confirming that the selected item was added to all users.

5 Click the OK button.
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Revoking all users’ access to an item at the same time

If some or all At Ease or restricted Finder users currently have access to an
item and you want to revoke everyone’s access, you can take advantage of a
shortcut in At Ease Setup to remove items from all users at once. Follow
these steps:

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Choose Remove Item From All Users from the Options menu.

The Remove File From Users screen appears, listing all items that at least
one At Ease or restricted Finder user currently has access to.

3 In the list of items, select the item you want to revoke all users’ access to.

4 Click the Remove button.

A message appears confirming that the selected item was removed from all
users.

5 Click the OK button.
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Giving users access to shared disks

The At Ease owner can give users access to file servers or shared disks by
creating buttons for them. You must connect to the shared disk before you can
create a button for it.

Once you have created the button, the user can access that disk. In most cases,
the user must be registered on the disk and must enter his or her name and
password after connecting. However, some shared disks allow guest access. 

To create an At Ease button for a shared disk you are connected to, follow
these steps:

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Select the user to whom you want to give access, then click Open.

3 Click the Next button.

4 Click the Find Items button.

The Find Items screen appears.

5 Type all or part of the name of the shared disk in the upper box.
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6 Click the Find button.

A list appears on the left, showing all items whose names contain the text you
typed, including any shared disks to which you are connected.

7 Select the shared disk in the list on the left, then click the Add button.

To select more than one item in the list, hold down the Shift key while you
click the name of each item.

As a shortcut, you can double-click items or drag them from the list on the
left to the list on the right.

When you have clicked Add, the shared disk you selected appears in the list
on the right. 

8 When you have finished searching and adding items, click OK.

9 Click the Next button.

10 Click the Next button again.

11 Click the Done button.

A button for the shared disk will appear on the user’s panel the next time the
user logs into At Ease.
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Setting application preferences

Some application programs use special files that come with the program. And
certain programs need to launch other programs (usually utility programs) in
order to work properly. Sometimes these files or programs may not be
available to a user because of security restrictions you have set for the user.

For example, the Writing Center comes with a set of pictures in the Pictures
Folder. To use these pictures, the Writing Center application program must
have access to that folder. But if a user does not have access to that folder, he
or she will not be able to see or use these pictures. 

The Application Preferences command lets the At Ease owner set a program’s
preferences. For most programs, the default settings in the Application
Preferences dialog box are appropriate. But if you find that a program isn’t
working properly with At Ease, you may need to change the application
preferences for the program.

To change the application preferences, follow these steps:

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Choose Application Preferences from the Settings menu.
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The Set Application Preferences screen appears.

3 In the list on the left, select the name of the program whose preferences you want to set.

The selected program’s current application preference settings appears at the
bottom of the window.

4 If you wish, click the checkboxes to change the settings.

The default setting for the “open location” and “save location” checkboxes is
active (selected) for most programs. These settings allow the program to
access the necessary preference files, even if they are stored in folders to
which the user doesn’t have access. 

The default setting for the “Can be launched by other applications” checkbox
is inactive (deselected) for most programs. When selected, this option allows
this program to be “sub-launched” by other programs even when a user
doesn’t have access to this program.

5 Repeat steps 4 and 5 for any other programs whose preferences you want to set.

6 When you are finished setting application preferences, click OK.
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Changing the user greeting

Whenever an At Ease user starts up the computer, a Welcome screen appears.
(If there is only one At Ease user, the Welcome screen will look somewhat
different from the one pictured here.)

The At Ease owner can change the greeting at the top of this screen.

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Choose Change User Greeting from the Options menu.
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The Change User Greeting screen appears.

3 Type a new user greeting and click OK.

The next time a user starts up with At Ease, the new greeting will appear at
the top of the Welcome screen.

Adding and removing button sounds

You can attach sounds to items that appear on any user’s At Ease panels. The
computer will play the attached sound whenever a user moves the pointer
over the button. (This is true even when the spoken button names feature has
been turned on.)

In order to attach a sound, you must either have a sound file or the
appropriate hardware and software to record a sound of your own.

Preparing to attach a sound

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Choose Attach Sounds from the Settings menu.
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The Attach Sounds screen appears.

This screen shows you the name of every item to which at least one At Ease
or restricted Finder user has been given access.

If the speaker icon to the left of an item name has wavy lines beside it, a
sound has already been added to the item. (You can remove the sound and
add a different one if you like.)

3 Click the name of the item to which you want to add a sound.

Now you can either import a sound or record one of your own.

Importing a sound

You must have a sound file on one of your disks in order to import a sound.
Before you import a sound, make sure an item is selected in the Attach
Sounds screen. (See the previous section for instructions.)
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1 Click the Import Sound button.

The Import Sound screen appears.

2 If necessary, use the pop-up menu to locate a sound file.

3 Click the name of the sound you want to import. 

If you want to hear the sound before importing it, click the Play Sound
button.

4 Click the Import button to add the sound.

Wavy lines appear beside the speaker icon, indicating that the item now has 
a sound attached to it. The item’s button will now play the sound when a user
points to it.

5 Click the Done button.
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Recording a sound

You must have the appropriate hardware and software in order to record a
sound. (See the documentation that came with your computer for more
information.)

Before you record a sound, make sure an item is selected in the Attach
Sounds screen. (See “Preparing to Attach a Sound” earlier in this chapter for
instructions.)

1 Click the Record Sound button.

The following window appears, with controls for recording sounds.

2 When you are ready to record a sound, click Record.

3 When you have finished recording, click Stop.

4 To hear the sound before you save it, click Play.

5 Click Save to save the sound.

Wavy lines appear beside the speaker icon, indicating that the item now has a
sound attached to it. The item’s button will now play the sound when a user
points to it.
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Removing a sound

Before you remove a sound, make sure an item is selected in the Attach
Sounds screen. (See “Preparing to Attach a Sound” earlier in this chapter 
for instructions.)

Click Remove Sound.

The wavy lines disappear from beside the speaker icon, indicating that the
item no longer has a sound attached to it. If the spoken button names feature
is activated for a particular user, the item’s button will now speak its name
when that user points to it.

Turning off At Ease

If you decide that you don’t want to use At Ease on your computer, you can
turn it off. 

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Click the Off button in the first screen.

The next time you restart your computer, it will start up with the Finder.
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Removing At Ease permanently

If you don’t want to use At Ease, it’s easiest just to turn it off. You can,
however, remove it permanently.

The procedure you follow to remove At Ease depends on whether you have
the At Ease Install disk available.

If you have the At Ease Install disk

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Click the Off button in the At Ease Setup screen.

3 Quit the At Ease Setup program.

4 Insert the At Ease Install disk into the disk drive.

If you don’t have this disk, see the instructions in the next section, “If You
Don’t Have the At Ease Install Disk.”

5 Double-click the Installer icon.

6 Click the Continue button in the Welcome screen that appears.

7 Choose Custom Remove from the pop-up menu.

WARNING  Do not attempt to remove At Ease without turning it off first.
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8 Select all available checkboxes.

Some checkboxes may be dimmed, indicating that the items are not installed
on your computer’s hard disk.

9 Click the Remove button.

A message appears to let you know that removal was successful.

10 Click the Restart button to restart the computer.

If you don’t have the At Ease Install disk

1 If necessary, open the At Ease Setup program, type the administrator password, and
click OK.

2 Click the Off button in the first screen.

3 Quit the At Ease Setup program.

4 Drag the At Ease files to the Trash.

The files you need to remove are

m the At Ease Setup Folder (at the top level of your startup hard disk, unless
you have moved it); this folder contains the At Ease Setup program and (if
you are running System 7.5 or a later version of system software) the At
Ease Setup Guide file

m the At Ease Items folder (in your System Folder)

m the At Ease file (also in your System Folder)

m the At Ease Guide file (also in your System Folder, if you are running
System 7.5 or a later version of system software)

m the At Ease Startup extension (in the Extensions folder of your System
Folder)

m the At Ease Setup Help file (in the Preferences folder of your System
Folder, if you are running System 7.0 or 7.1)

5 Hold down the Option key while you choose Empty Trash from the Special menu.

WARNING  Do not attempt to remove At Ease without turning it off first.
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This chapter includes tips for using At Ease most effectively, as well as
suggestions for what to try if you run into problems using At Ease Setup or 
At Ease. This chapter also includes several points you should know if you’re
using At Ease 3.0 with System 7.5.

If you’re having a problem and can’t find an answer here or elsewhere in 
this manual (or in At Ease Guide or At Ease Setup Guide, available in the
Guide [h] menu if you’re using System 7.5 or a later version), see the service
and support information that came with your computer for information about
contacting Apple for additional help.
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General tips
m Do not move the Finder or the At Ease Items folder out of your System

Folder. (At Ease may not work properly if the Finder is not present.)

m If you want to give a user access to Apple II programs, you must use the
Find Items feature during the registration process. The Add Applications
feature does not recognize Apple II programs.

m If an At Ease user saves a document in a folder other than his or her user
folder, the document will not appear on the user’s panel.

m When you’re using the Copy To Floppy or Copy From Floppy command,
clicking Stop does not interrupt copying of the file in progress, but stops
copying after it has been completed. Any additional files you selected are
not copied.

m Do not run an Installer for another program from within At Ease. Turn off
At Ease, return to the Finder, and then run the Installer for the other
program.

m If you have turned on the spoken button names feature for a user, make
sure that virtual memory is turned off whenever that user is logged into 
At Ease.

Troubleshooting suggestions

When I use the Find Items feature during the registration process, At Ease Setup doesn’t
find an item that I know is on the disk.

The characters you typed may not exactly match those in the item’s name.
Make sure you have included any necessary spaces or punctuation marks
when you type in the name. Also, the Find Items feature does not find aliases
or any other items that can’t be opened (such as an extension or the System
file).

I can’t place an alias for a folder of items in the Documents folder for an At Ease user. 

For security reasons, At Ease does not allow aliases for folders, except for the
shared folder.
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When At Ease is running and I try to install another application program on my startup
disk, the pointer freezes on the screen.

Either turn off file sharing in the Sharing Setup control panel or turn off 
At Ease in the At Ease Setup program. Then install the other program.

Documents for At Ease users no longer show up on their At Ease panels.

You may have moved the Documents folder to a new location. The
Documents folder must be either at the main level of the startup disk or 
on the desktop. If you’ve moved it, return it to one of these locations.

When I start up the computer, I see a message that At Ease has encountered an error.

Check to make sure your startup disk is not locked. (This is most likely to
happen if you’re using a removable cartridge drive for your startup disk.)
Select the startup disk icon and choose Get Info from the File menu. If the
Locked checkbox is selected, click it to remove the X.

If this does not solve the problem, the At Ease Setup information has
probably been corrupted. If you have made a backup copy of your At Ease
Items folder, you can try restoring it. Otherwise, you will need to reinstall 
At Ease, following these steps:

1. Restart the computer, holding down the Shift key.

2. If you have an administrator password, type the password and go to the
Finder.

3. Throw away the At Ease Items folder and restart the computer.

4. Install At Ease and set it up again. (For complete installation instructions,
see Chapter 2.)

Whenever I try to throw away the At Ease Items folder from the Finder and empty the
Trash, I get a message that says some items are locked and could not be thrown away.

Some files in the At Ease Items folder are intentionally locked to prevent
unauthorized deletion from within another program. If you want to delete the
At Ease Items folder, drag it to the Trash and hold down the Option key while
you choose Empty Trash from the Special menu.
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If you forget the administrator password

If you’ve forgotten the administrator password, it’s possible to set a new one. 

IMPORTANT  Following this procedure will also turn off At Ease, reset any
application preferences you had changed, and reset the user greeting to
“Welcome to At Ease” (if you had changed it). For instructions on changing
the user greeting, see “Changing the User Greeting” in Chapter 4.

1 Start up your computer from another startup disk.

You’ll need to start up from another disk that has system software on it. If
your computer came with a disk called Disk Tools, you can use that disk.

2 Open the System Folder of your usual startup disk.

3 Open the At Ease Items folder inside your System Folder.

4 Drag the At Ease Preferences file into the Trash.

5 Hold down the Option key while you choose Empty Trash from the Special menu.

6 Restart from your usual startup disk.

7 Open the At Ease Setup program and set a new password.

For instructions, see “Setting an Administrator Password” in Chapter 3.

8 Before quitting the At Ease Setup program, turn on At Ease again.

For instructions, see “Turning On At Ease” in Chapter 3.
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Tips for using At Ease 3.0 with System 7.5

At Ease 3.0 is compatible with System 7.5. However, some control panels and
other features of System 7.5 may work differently while At Ease is running.
This section provides information on these differences. Please refer to
Macintosh Guide, available in the Guide (h) menu, for more information on
these topics.

AppleScript

Scripts written using AppleScript can be launched by At Ease. However,
scripts that require the Finder will not run properly.

Extensions Manager

You cannot change the settings in this control panel while At Ease 3.0 is
running.

Find File

When At Ease 3.0 is open, the Find File command does not let you open or
print items that are found.

General Controls control panel

Documents

This option can control where the Documents folder is created on your
computer. At Ease always tries to open or save a document in the user’s folder,
within the At Ease Documents folder, regardless of the settings in the
Documents option.

If At Ease is running and you have not changed the Documents option, 
At Ease creates the Documents folder on the startup disk. If At Ease is not
running and you select the Documents folder button, the Documents folder 
is created on the desktop.

Launcher

The Launcher does not work with At Ease 3.0. If At Ease is turned on, the
Launcher will not open at startup even if an alias to it is present in the
Startup Items folder.
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Macintosh Easy Open (version 1.1 or later)

If a user attempts to open a document without the application program that
created it and Macintosh Easy Open is active, a message appears asking the
user if he or she wants to open the document with another program. (Only
programs that were made available to the user in the At Ease Setup program
will appear in the list of programs.)

PowerTalk

Apple recommends that PowerTalk and At Ease not be used together, as some
of PowerTalk’s features will not work correctly.

QuickDraw GX

At Ease now supports printing with QuickDraw GX. However, once you start
a print job, you cannot quit At Ease or go to the Finder until printing is
completed. If QuickDraw GX is installed, print jobs that are stopped cannot
be restarted within At Ease. The user (or the owner, if the user doesn’t have
access to the Finder) must go to the Finder to restart a print job.

Printer menu

When a user has access to the Chooser and QuickDraw GX is active, a new
menu called “Printer” appears in At Ease. This menu contains all desktop
printers that have been created, with a checkmark beside the name of the
currently selected printer. To select a different printer, simply choose its name
from the Printer menu.
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Printer Status command

To view the status of the currently selected printer, choose Printer Status from
the Printer menu. Print jobs started by the computer appear in the Printer
Status window. A pop-up menu allows you to view the status of other
printers.

Apple menu options

Users who start up with the At Ease panels do not see the Recent
Applications, Recent Documents, or Recent Servers folders in the Apple (K)
menu. 

Users who start up with the restricted Finder see all three Recent folders, but
their Recent Documents folder is deleted each time they quit At Ease. For that
reason, there are no items in the Recent Documents folder at the beginning of
a work session: documents are added to the folder only as they’re used during
the current work session.

If an At Ease or restricted Finder user has been given access to control panels,
you can also give him or her the option to see a submenu for the Control
Panels folder in the Apple menu.

73Tips and Troubleshoot ing





This appendix provides information on the day-to-day use of the At Ease
working environment. The tasks described in this chapter are useful for all 
At Ease users—not just the owner. You may want to photocopy this appendix
and share it with those users who work in the At Ease environment.

Starting up with At Ease

When you start up your computer with At Ease, a Welcome screen appears.
(If there is only one At Ease user, the Welcome screen will look somewhat
different from the one pictured here.)
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1 Select your name in the list on the left and click the Start button.

The Enter Password screen appears.

If the At Ease owner did not assign you a password, you will see the At Ease
desktop immediately upon logging in—you won’t see the Enter Password
screen.

2 Type your password and click OK.

You see the At Ease panels. (Your panels may look somewhat different from
the ones pictured here.)
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A first look at At Ease

The At Ease desktop includes at least one panel—the At Ease Items panel,
which displays a button for each application program or document that is
available to you. You may also see a user panel (labeled with your name) that
contains items that you have saved in your personal area, as well as panels for
any floppy disks and CD-ROM discs in drives connected to the computer.

The menus and menu commands you see depend on the access privileges you
have been given by the At Ease owner. For an explanation of the menu
commands, see “At Ease Menus” later in this chapter.
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Switching between At Ease panels

There are three ways to switch between At Ease panels to find the documents
or programs you want to work with.

m Choose the panel you want from the Panels menu.

The currently active panel is indicated by a checkmark in the Panels menu.

m Click the tab of the panel you want.

m Press the Tab key on the keyboard until the panel you want is the active panel.
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“Paging” through At Ease panels

If an At Ease panel contains more programs and documents than can be
displayed at one time, a new “page” is added to the panel. An upturned page
corner with an arrow appears in one or both bottom corners of the panel to
indicate that there are additional items. The page number also appears at the
bottom of the panel. 

There are several ways to move between pages in At Ease:

m To go to the previous page, click the arrow in the lower-left corner; or, press the Left
Arrow (k) key on the keyboard.

m To go to the next page, click the arrow in the lower-right corner; or, press the Right
Arrow (˚) key on the keyboard.

m To go directly to a specific page, hold down the Command (x) key while you type the
number of the page.

This method works only for pages 1 through 9.

m To go to the first page, hold down the Command (x) key while you press and release
the Left Arrow (k) key on the keyboard.

m To go to the last page, hold down the Command (x) key while you press and release
the Right Arrow (˚) key on the keyboard.
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Opening programs, documents, and folders
m To open a program, document, or folder in At Ease, click its button once.

When you open a program or document, the At Ease desktop disappears, and
you see the window of the program or document that you’ve opened.

When you open a folder, a new panel representing the folder’s contents
appears as the active panel.

At Ease menus

This section describes each of the At Ease menu commands. (Many of these
commands work differently from those in the Macintosh Finder menus.)

All At Ease users see the commands described in this section as “always
available.” Whether you see commands described as “optional” depends on
the access privileges you have been assigned by the At Ease owner.

The Apple menu

The items in the Apple (K) menu are described in the manuals or on-screen
help that came with your computer. Please refer to those sources if you have
questions about Apple menu items. Note, however, that At Ease does not
display folders (except for the Control Panels folder) in the Apple menu.
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The File menu

The commands you see in the File menu depend on the access privileges you
have been assigned by the At Ease owner. The following illustration shows all
possible File menu commands.

New Folder (optional)

If you have access to the New Folder command, you can use it to create new
folders on your user panel or the panel for a floppy disk. After a new folder is
created, you can save new documents in the folder, but you can’t move any
documents into the new folder. 

To create a new folder, follow these steps:

1 If necessary, choose the panel on which you want to create a new folder from the Panels
menu.

2 Choose New Folder from the File menu.

The New Folder screen appears.
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3 Type a name for the folder in the text box, and then click New Folder.

A button for the new folder appears on the active panel.

Open Other (optional)

If you have access to the Open Other command, you can use it to open 
any program or document on any disk (unless you are required to open
documents from your documents folder).

To open an item, follow these steps:

1 Choose Open Other from the File menu.

The Open Other screen appears.

2 If necessary, use the pop-up menu to move to a different level or a different disk.

3 Select the item you want, and then click Open.

The Open Other screen disappears, and the window of the selected program
or document appears.

Close (always available)

This command allows you to close any folder panel that is currently open. It
does not close the main At Ease panels, however.
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Rename (optional)

If you have access to the Rename command, you can use it to rename any
document or folder on your user panel or a floppy disk panel. Items on other
panels can’t be renamed.

To rename an item, follow these steps:

1 If necessary, choose the panel that contains the item you want to rename from the
Panels menu.

2 Choose Rename from the File menu.

The first Rename screen appears.

3 Select the item you want to rename, and then click Rename.

The second Rename screen appears.

4 Type a new name for the item in the text box, and then click Rename.

The second Rename screen disappears, and the item has been renamed.
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Delete (optional)

If you have access to the Delete command, you can use it to delete any
document or folder on your user panel or a floppy disk panel. Items on other
panels can’t be deleted.

Locked items can’t be deleted. (For information on unlocking an item so that
it can be deleted, see “Get Info,” the next section in this chapter.)

If you delete a folder, you will also delete its contents permanently.

To delete an item, follow these steps:

1 If necessary, choose the panel that contains the item to be deleted from the Panels
menu.

2 If necessary, open folders until the item you want to delete is visible.

3 Choose Delete from the File menu.

The Delete screen appears.

4 Select the item or items you wish to delete.

To select more than one item, hold down the Shift key while you click each
name.

5 Click Delete.

A message appears asking whether you really want to delete the selected item
or items.

6 To permanently delete the item or items, click Delete again.

If you decide you don’t want to delete the item or items, click Cancel.
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Get Info (optional)

If you have access to the Get Info command, you can use it to get information
about any item on any At Ease panel. 

You can also use the Get Info command to lock and unlock documents and to
make a document into a stationery pad—that is, a document that serves as a
template for other documents. (When you open a stationery pad, you are
actually creating a copy that can be changed; the original remains
unchanged.) The locking and stationery pad features apply only to documents
on your user panel or a floppy disk panel.

To use the Get Info command, follow these steps:

1 If necessary, choose the panel that contains the item you want information about from
the Panels menu.

2 Choose Get Info from the File menu.

The Get Info screen appears.
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3 Select the item you want information about, and then click Get Info.

An information box appears.

4 If you want to lock the item, click the Locked checkbox to select it. (You can unlock the
item by clicking the checkbox again to deselect it.)

When a document is locked, you can open and copy its contents, but you
can’t change or delete the file.

Only documents on your user panel or a floppy disk panel can be locked and
unlocked.

5 If you want to make the item a stationery pad, click the checkbox labeled “Stationery
pad” to select it.

Only documents on your user panel or a floppy disk panel can be made into
stationery pads.

6 When you’re finished using the Get Info feature, click OK.
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Find (optional)

If you have access to the Find command, you can use it to find items on any
At Ease panel (or in any folder on an At Ease panel). To find an item, follow
these steps:

1 Choose Find from the File menu.

The Find screen appears.

2 Type the name (or part of the name) of the item you want to find in the text box.

Typing part of the name can be a useful shortcut. However, if you type too
short a selection, you may find more items than you want. For example,
typing “car” would find all of the following items: “car,” “carnation,” “car
repairs,” “day care,” and “scarf.”

3 Click Find.

A list appears in the Items Found box, showing all items whose names
contain the text you typed.

4 Select the name of the desired item.

Information about the selected item appears in the Info box, and the Go To
button becomes active.

5 Click Go To.

The Find screen disappears, and At Ease takes you to the panel with the
selected item. The item flashes to help you locate it.
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Copy To Floppy (optional)

If you have access to the Copy To Floppy command, you can use it to copy
items from your user panel onto a floppy disk. 

To copy items to a floppy disk, follow these steps:

1 If necessary, choose your user panel from the Panels menu.

2 Choose Copy To Floppy from the File menu.

If there is no disk in the floppy disk drive, At Ease prompts you to insert one.

The Copy To Floppy screen appears.

3 Select the item or items you want to copy.

To select more than one item, hold down the Shift key while you click each
name.

4 If you want to delete the item or items from your user panel after copying them to a
floppy disk, click the “Delete originals after copying” checkbox to select it.

5 Click Copy.

A message appears on the screen, showing you the status of the copying
process. When the message disappears, the process is complete.

Note:  If you click the Cancel button after copying has begun, At Ease will
finish copying the item in progress but will not copy any additional items.
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Copy From Floppy (optional)

If you have access to the Copy From Floppy command, you can use it to copy
items from a floppy disk to your user panel. 

To copy items from a floppy disk, follow these steps:

1 If necessary, choose your user panel from the Panels menu.

2 Choose Copy From Floppy from the File menu.

If there is no disk in the floppy disk drive, At Ease prompts you to insert one.

The Copy From Floppy screen appears.

3 Select the item or items you want to copy.

To select more than one item, hold down the Shift key while you click each
name.

4 If you want to delete the item or items from the floppy disk after copying them to your
user panel, click the “Delete originals after copying” checkbox to select it.

5 Click Copy.

A message appears on the screen, showing you the status of the copying
process. When the message disappears, the process is complete.

Note:  If you click the Cancel button after copying has begun, At Ease will
finish copying the item in progress but will not copy any additional items.
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Quit (always available)

This command returns you to the At Ease Welcome screen. From there, you
can shut down the computer, or another user can start up At Ease.

Any floppy disks in the computer’s floppy disk drives are ejected when you
choose Quit.

The Edit menu

All users see the same Edit menu commands.

The commands in the Edit menu of At Ease are available only if you have
selected a command that asks you to enter text (such as Rename or Find).
Otherwise, the commands are dimmed. The At Ease Edit commands work
exactly the same way as those in a program’s Edit menu.

The View menu (optional)

If you have access to the commands in the View menu, you can use them to
change the way items on an At Ease panel are arranged.

A checkmark indicates the current method of arrangement.
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To change your view, follow these steps:

1 If necessary, choose the panel whose arrangement you want to change from the Panels
menu.

You cannot change the arrangement of a CD-ROM disc panel.

2 Choose a view from the View menu.

There are four possibilities:

m By Name arranges the items in alphabetical order. (This is the default view.)

m By Size arranges the items according to size, starting with the largest item.
When the pointer moves over the name of an item, At Ease displays the
size below the name.

m By Kind arranges the items in alphabetical order by category (application
program, document, and so on); in addition, documents are organized in
alphabetical order by the program in which they were created. When the
pointer moves over the name of an item, At Ease displays its kind below
the name.

m By Date arranges the items by the date they were last modified, starting
with the most recently modified item. When the pointer moves over the
name of an item, At Ease displays the date it was last modified below 
the name.

The Special menu

The commands you see in the Special menu depend on the access privileges
you have.
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Turn Sound Off (always available)

At Ease can make sounds when you move from one page to another, when
you click a button, and when the pointer passes over an item. This command
lets you turn off these sounds.

When sound has been turned off, this menu command changes to “Turn
Sound On.”

Eject Disk (always available)

This command lets you eject any ejectable disk (such as a floppy disk or a
CD-ROM disc) as well as an AppleShare volume (shared disk). If more than
one disk is present, you will see a list to choose from when you choose this
command.

If only one disk is present, the command name changes to “Eject <Name of
Your Disk>.” For example, if a disk named “XYZ” is in the floppy disk drive,
the command name will read “Eject XYZ.”

Go To At Ease Setup (always available)

This command takes you to the At Ease Setup program. If the At Ease owner
has set an administrator password, you will be required to provide this
password before you can gain access to At Ease Setup. Changes you make in
At Ease Setup will not take effect until you quit At Ease and return to the
Welcome screen.

Go To Finder (optional)

This command is available if the At Ease owner has given you unrestricted
access to the Finder. Choosing this command brings the Finder forward; At
Ease still runs in the background. You can return to At Ease by choosing Go
To At Ease from the File menu of the Finder, or by choosing At Ease from the
Application menu.

Restart (always available)

This command restarts the computer. Any floppy disks are ejected in the
process of restarting. When the computer restarts, you see the At Ease
Welcome screen.
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Shut Down (always available)

This command shuts down the computer after first prompting you to save any
open documents. Floppy disks are ejected in the process of shutting down.

Saving documents

When you save a new document, your choice of locations is determined by a
setting in the At Ease Setup program. Check with the At Ease owner to see
which of the following settings applies to you:

m Anywhere: You are allowed to save your documents anywhere on any disk.
When you choose the Save or Save As command, you are presented with 
a directory dialog box that lets you select the location of your choice. Only
items saved in the folder labeled with your name will appear on your user
panel.

m Only in your user folder: You can save documents only in your personal
folder on the startup disk. When you choose the Save or Save As
command, you are presented with a directory dialog box that lets you save
directly into your folder. (If you have access to the New Folder command,
you can create additional folders within your personal folder.) When you
return to the At Ease desktop, your documents appear on your user panel.

m Only on a floppy disk: You must use floppy disks to save your documents.
When you choose the Save or Save As command, you are prompted to
insert a floppy disk (unless one is already in a floppy disk drive).

m Only in your user folder or on a floppy disk: You can save documents either
in your personal folder on the startup disk or on floppy disks. When you
choose the Save or Save As command, you are presented with a directory
dialog box that lets you save either directly into your folder or onto a
floppy disk.

m Nowhere:  You cannot save documents anywhere. When you choose the
Save or Save As command, you see a message reminding you that you do
not have the access privileges to save documents.

For more information on saving documents, refer to the manuals or on-screen
help that came with your computer.
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Changing your password

You can change the password given to you by the At Ease owner, as part of
the process of starting up with At Ease.

If you were not given a password by the At Ease owner, you cannot use this
procedure.

1 When you start up the computer, click the Change button in the Enter Password screen.

The Change Password screen appears.

2 Type your current password in the upper box, then type your new password in the
middle and lower boxes.

As you type, dots (•••) appear in place of the text so that anyone nearby will
be unable to see what password you have typed.

3 Click OK.
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Setting the number of colors for a program

At Ease lets you set the number of colors (also called the monitor depth) that
an application program will display when you use it. If you don’t set the
number of colors for a program, the program will display the number of
colors set in the Monitors control panel. (Only users with access to the
Control Panels folder in the Apple menu can adjust the control panel.)

To set the number of colors, follow these steps:

1 Hold down the Option key while you click the program’s button.

The Monitor Depth screen appears.

2 Use the pop-up menu to select a number of colors or grays.

If you select a number of colors that your monitor does not support, your
setting will have no effect.

When you select a number of colors in the pop-up menu, an X automatically
appears in the box labeled “Set the screen to.” (To cancel your selection later,
simply click this box to remove the X.)

3 Click OK.
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Getting help

As you’re learning At Ease, you may want to take advantage of Balloon Help,
which lets you get information about items on the screen simply by pointing
to them with the mouse. If you are using system software version 7.5 or later,
you can also take advantage of At Ease Guide, which provides background
information and step-by-step instructions on the screen.

Using Balloon Help

1 Choose Show Balloons from the Help (H) menu (System 7.0 or 7.1) or the Guide (h)
menu (System 7.5).

When you have turned on Balloon Help, the menu command name changes to
“Hide Balloons.”

2 Point to an item on the screen.

A balloon appears with a description of the item.

3 When you no longer need Balloon Help, choose Hide Balloons from the Help menu.
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Using At Ease Guide

1 Pull down the Guide menu (marked with the h icon near the right end of the menu bar)
and choose At Ease Guide.

The At Ease Guide access window appears.

Whenever you use At Ease Guide, its window—either this access window or a
panel displaying instructions—remains in front of other windows. If the
window gets in your way, you can move it by dragging its title bar (the gray
bar across the top of the window). Instruction panels also have a zoom box in
the upper-right corner that lets you quickly reduce the size of the panel.

2 Notice the three buttons at the top of the window: Topics, Index, and Look For.
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At Ease Guide gives you three ways of finding information:

m Topics lets you choose from a list of general subjects; it is like the table of
contents in a book.

m Index lets you choose from an alphabetical list of more specific subjects; it
is like the index in a book.

m Look For lets you search for information related to a specific word or phrase
that you type.

Getting information with the Topics button
If you prefer to find information by topic, follow these steps:

1 In the At Ease Guide access window, click the Topics button.

A list of general topics appears on the left side of the window.

2 Click the desired topic area in the list of topics.

When you click any topic area, a list of related questions appears on the right
side of the At Ease Guide access window.

3 Click the desired phrase or question in the list on the right, and then click OK. (Or
double-click the phrase or question.)

A small window appears with information or instructions. If the information
requires more than one panel, the right arrow in the lower-right corner is
active. You can click this arrow to move to the next panel of the instructions.

4 When you have finished reading the information or following the instructions on all the
panels in the sequence, click the Topics button in the lower-left corner to return to the At
Ease Guide access window. Or, if you are finished using At Ease Guide, click the close
box in the upper-left corner to close At Ease Guide.
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Getting information with the Index button
If you prefer to find information by index term, follow these steps:

1 In the At Ease Guide access window, click the Index button.

An alphabetical list of subjects appears on the left side of the window.

2 If necessary, scroll through the alphabetical list until the desired subject appears.

You can scroll through the list either by dragging the slider to the desired
letter or by using the scroll bar at the right of the list.

3 Click the desired subject in the alphabetical list.

When you click any index entry, a list of related questions appears on the
right side of the At Ease Guide access window.

4 Click the desired phrase or question in the list on the right, and then click OK. (Or
double-click the phrase or question.)

A small window appears with information or instructions. If the information
requires more than one panel, the right arrow in the lower-right corner is
active. You can click this arrow to move to the next panel of the instructions.

5 When you have finished reading the information or following the instructions on all the
panels in the sequence, click the Topics button in the lower-left corner to return to the At
Ease Guide access window. Or, if you are finished using At Ease Guide, click the close
box in the upper-left corner to close At Ease Guide.
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Getting information with the Look For button

If you prefer to find information by searching for a specific word or phrase,
follow these steps:

1 In the At Ease Guide access window, click the Look For button.

A small box appears on the left side of the window, where you can type text.

2 Click the arrow button to the left of the text box (or click inside the text box) to activate
the box.

3 Type the desired word or phrase in the text box and then click Search.

When you click Search, a list of questions related to the word or phrase you
typed appears on the right side of the At Ease Guide access window.

If At Ease Guide is unable to locate any information on the word or phrase
you typed, you’ll see a message to that effect on the right side of the access
window. Try typing a different word or phrase.

4 Click the desired phrase or question in the list on the right, and then click OK. (Or
double-click the phrase or question.)

A small window appears with information or instructions. If the information
requires more than one panel, the right arrow in the lower-right corner is
active. You can click this arrow to move to the next panel of the instructions.

5 When you have finished reading the information or following the instructions on all the
panels in the sequence, click the Topics button in the lower-left corner to return to the At
Ease Guide access window. Or, if you are finished using At Ease Guide, click the close
box in the upper-left corner to close At Ease Guide.
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Tips and shortcuts

This section describes a number of tips and shortcuts that can help you to use
At Ease more efficiently.

Moving quickly to a particular item on a panel

At Ease allows you to move quickly to a particular item on another page of a
panel.

To move quickly to an item, follow these steps:

1 If necessary, choose the name of the panel that contains the item from the Panels menu.

2 Type the first character or characters of the item’s name.

At Ease takes you to the page of the panel where the item appears. The item
flashes to help you locate it.

Moving quickly between folders

If you have opened several levels of folders, you can use the following
shortcut to move quickly between them:

1 Position the pointer over the topmost folder’s name and hold down the mouse button.

A pop-up menu appears, showing all the folders that contain the current
folder.

2 Drag through the pop-up menu until the desired folder is highlighted, then release the
mouse button.

At Ease takes you directly to the desired folder.
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Shortcuts for closing folders

If you have opened one or more folders on your user panel, you can use the
following shortcuts to close one or all of them:

m To close only the topmost folder, click its close box.

The close box is located on the folder’s tab, to the left of the folder’s name 
and icon.

m To close all open folders, hold down the Option key while you click the close box of
the topmost folder.

Working with more than one application program

You can work with more than one application program at a time in At Ease.
Follow these steps:

1 Open the first program you want to work with.

Your document window appears.

2 Choose At Ease from the Application menu.

The Application menu is the farthest to the right in the menu bar.

The At Ease panels reappear.

3 Open the second program.

The second document window opens. You can switch from one open program
to the other by clicking in the window of the program you want, or by
choosing the desired program from the Application menu.
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This appendix provides instructions for starting up the computer for restricted
Finder users and outlines the main differences between the regular Finder
and the restricted Finder. You may want to photocopy this appendix and share
it with restricted Finder users.

Starting up with the restricted Finder

When At Ease is turned on, every user sees the same Welcome screen upon
starting up the computer. (If there is only one registered user, the Welcome
screen will look somewhat different from the one pictured here.)
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1 Select your name in the list on the left and click the Start button.

The Enter Password screen appears.

If the At Ease owner did not assign you a password, you will proceed to the
restricted Finder without seeing the Enter Password screen.

2 Type your password and click OK.

At Ease takes a few moments to prepare the restricted Finder. Any unlocked
items that were left on the desktop of the startup disk by a regular Finder user
are placed in a folder called “Secured Items” during this process.

Messages appear to show the progress of the preparation. Then you see the
following screen:
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A window labeled “Items for <Your Name>” opens automatically. This
window usually includes two folders:

m “Items for <Your Name>” contains all the programs and documents that
the At Ease owner has given you access to.

m “<Your Name>” is your personal folder, where you can store your own
documents, create your own folders, and so on. (If the At Ease owner has
limited you to opening and saving items only on floppy disks, you won’t
see this folder.)

When you open these two folders, the screen looks something like this:

You can move and resize these windows during this work session. They will
close automatically when you restart the computer, and the next time you
open the folders, they will have the standard sizes and positions shown here.

Note:  Because the two folder windows have the same name (your user name),
you may prefer to leave the windows in their default position. That way, you
won’t be confused about which window is which.
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Differences between the regular Finder and the restricted Finder

Users familiar with the regular Finder should note the following differences:

m You can open only those application programs that the At Ease owner has
given you access to (the ones that appear in the “Items for <Your Name>”
folder or in the Apple menu).

m You can open a document only if it was created with one of the application
programs that the At Ease owner has given you access to, or if it can be
opened by a program that the At Ease owner has given you access to. (For
example, if you have access to the SimpleText program, you may be able to
open documents created by certain other word-processing programs, even
if you don’t have access to the creating program.)

m You can open most folders on the computer’s disks—but you can’t open the
personal folders of other users or the Secured Items folder.

m You can throw away only those items in the folder labeled “<Your Name>.” 

m You can’t move any items onto the desktop.

m You can rename only those items in the folder labeled “<Your Name>.”

m If you haven’t been given the access privileges to open and save items on
floppy disks, the computer will automatically eject any floppy disk that you
try to insert.

m When you drag an item from a floppy disk into the folder labeled “<Your
Name>,” you create a copy of the item in your folder. Keep in mind,
however, that you will not be able to open the item—even if it’s in your
own folder—unless you have been given access to the application program
that was used to create it.

m File sharing cannot be used when you are in the restricted Finder.
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access privileges
changing  17–18, 32, 42, 44, 46
for floppy disks  25, 26, 37, 38, 106
to menu commands  80
setting  23–32, 35–42

Add Applications screen  23–24, 35–36
Add File screen  52
Add New CD-ROM screen  50
administrator password

forgotten  70
logging in with  22, 34
setting  17–18

aliases for folders  68
Apple Guide, on-screen setup 

instructions  14
Apple menu  80
Apple menu items  73, 80

setting user access to  39–40
AppleScript, launching scripts  71
AppleShare volume. See shared disks
Apple II programs, setting user access to

23, 35, 68
application preferences feature  56–57

application programs
installing  69
opening  80, 82, 106
removing user access  25, 37
running multiple  102
setting number of colors  95
setting preferences  56–57
setting user access to  23–25, 35–37

arrow keys, paging through panels  79
At Ease Guide  3, 96, 97–100
At Ease Guide access window  97
At Ease Install disk  3, 6, 64–65
At Ease Items folder

deleting  69
restoring setup information  69

At Ease Items panel  77
At Ease menu commands  80–93

access privileges  77, 80
setting user access to  27–28, 39–40

At Ease menus  80–93
At Ease panels  2, 20

arranging items on  90–91
Balloon Help  3, 96
illustrated  76
paging through  79
reducing size  14
registering users  21–32
switching between  78
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At Ease program  1–2, 68
installing  5–7
installing other programs from  68
quitting  90
reinstalling  69
removing permanently  64–65
restrictions on copying  5
setting up  11–47, 49–65
skills required  3
starting up with  75–76
system requirements  5
with System 7.5 software  71–73
tips and shortcuts  101–102
turning off  63
turning on  47
working environments  20
working in  75–102

At Ease Setup Guide  3, 14–17
closing  15, 16, 17

At Ease Setup Guide access window
14–17

At Ease Setup information, restoring  69
At Ease Setup program. See also setting

up At Ease
accessing from the Special menu  92
advanced features  49–65
basic setup procedures  11–47
duplicating an existing user’s

privileges  45
on-screen instructions  13–17
opening  12
quitting  47
registering At Ease panels users

20–32
registering regular Finder users  42–44
registering restricted Finder users

33–42
removing users  46
turning on At Ease  47

Attach Sounds screen  60–63

B

Balloon Help  3, 96
buttons

adding/removing sounds  59–63
attached sounds  29
for shared disks  54–55

by Date command (View menu)  91
by Kind command (View menu)  91
by Name command (View menu)  91
by Size command (View menu)  91

C

CD-ROM discs
customizing access to  49–51
ejecting  92
panels for  77
setting user access to items on  25, 26,

37, 38
CD-ROM Preferences command

(Settings menu)  49
CD-ROM Preferences screen  25, 26, 37,

38, 50
Change Password screen  18, 94
Change User Greeting screen  59
Chooser desk accessory, setting user

access to  39–40
Close command (File menu)  82
colors, setting number of  95
commands. See menu commands; and

names of specific commands
control panels, setting user access to

39–40
Control Panels folder  73, 80, 95
Copy From Floppy command (File

menu)  68, 89
Copy To Floppy command (File menu)

68, 88
custom installation  7
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D

Delete command (File menu)  84
deleting documents and folders  84, 88
desktop

At Ease  1–2
Macintosh  2

Disk pop-up menu (Find Items screen)
26, 38

disks. See CD-ROM discs, floppy disks
documents

deleting  84
locking/unlocking  85–86

making into stationery pads  85–86
opening  80, 82, 106
renaming  83
saving  93
setting user access to  26, 38
storage location of  68, 93

Documents folder  69, 71
Documents option (General Controls

control panel)  71
Duplicate User screen  45

E

Edit menu  90
Eject Disk command (Special menu)  92
Enter Password screen  76, 94, 104
Extensions Manager, changing 

settings  71

F

File menu  81–90
files. See also documents

setting user opening/saving privileges
30, 40–41

file servers. See shared disks

file sharing
and installing application 

programs  69
and the restricted Finder  106

Find command (File menu)  87
Finder. See also restricted Finder

accessing from the Special menu  92
allowing user access to  32, 44
compared with the restricted 

Finder  106
registering users  42–44

Find File command, opening/printing
items  71

Find Items feature  23, 68
Find Items screen, setting user access to

items  26–27, 38, 54–55
Find screen  87
floppy disks

access privileges  25, 26, 37, 38, 106
copying items to/from  88–89
ejecting  24, 92
panels for  77
saving documents to  93
setting user access to items on  25, 26,

37, 38
setting user opening/saving privileges

30, 40–41
folder panels, closing  82
folders

aliases for  68
closing  102
creating new  81–82
deleting  84
moving between  101
opening  80, 106
renaming  83
setting user opening/saving privileges

30, 40–41



G

General Controls control panel
Documents option  71
Launcher  71

Get Info command (File menu)  85–86
Go To At Ease Setup command (Special

menu)  92
Go To Finder command (Special 

menu)  92
Guide menu  14

H

help. See At Ease Guide; At Ease Setup
Guide; Balloon Help

Help window (At Ease Setup)  13

I, J, K

importing sounds  60–61
Import Sound screen  61
Index button (At Ease Setup Guide

access window)  15, 16, 97, 
98, 99

information control  1
Installer program  6–9
installing At Ease  5–9

custom installation  7
on a hard disk  6–7

installing Mouse Practice  8–9
items. See also application programs;

documents; files; folders
adding/removing sounds  59–63
copying to/from floppy disks  88–89
deleting after copying  88–89
finding  87
getting information about  85–86
giving/revoking all users’ access to

52–53
moving quickly to  101
setting user access to  23–32, 35–42
setting user opening/saving privileges

30, 40–41

L

Launcher (General Controls control
panel)  71

license agreement  5
locking documents  85–86
Look For button (At Ease Setup Guide

access window)  15, 16–17, 97,
98, 100

M

Macintosh desktop  2
Macintosh Easy Open  72
memory requirements  5
menu commands  80–93

access privileges  77, 80
setting user access to  27–28, 39–40

menus  80–93
monitor depth, setting  95
Mouse Practice Install disk  8
Mouse Practice program

installing  8–9
setting user access to  24, 36

N

New Folder command (File menu)
81–82

New User screen  19–20
assigning passwords  22, 33–34, 43

O

on-screen setup instructions  13–17
with system software version 7.0 

or 7.1  13
with system software version 7.5 

or later  14–17
Open Other command (File menu)  82
owner

defined  1–2
registering  19–20
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P

pages, of At Ease panels  79
panels. See At Ease panels
Panels menu  78
password

administrator  17–18, 22, 34, 70
changing  22, 34, 43, 45, 94
entering  76, 104
owner  19
user  21–22, 33–34, 43

PowerTalk  72
Printer menu (QuickDraw GX)  72
printers

selecting  72
viewing status of  73

printing, with QuickDraw GX  72–73
Print Status command (QuickDraw 

GX)  73
privileges. See access privileges
programs. See application programs

Q

question mark icon  13, 14
QuickDraw GX  72–73

Printer menu  72
Print Status command  73

Quit command (File menu)  90

R

RAM (random-access memory)
requirements  5

Read Me file  3
Recent Applications folder  73
Recent Documents folder  73
Recent Servers folder  73
recording sounds  62
registering

At Ease panels users  20–32
regular Finder users  42–44
restricted Finder users  33–42

regular Finder. See Finder
Remove File From Users screen  53
Rename command (File menu)  83
renaming documents and folders  83, 106
Restart (Special menu)  92
restricted Finder  2, 20, 103–106

compared with the regular Finder  106
registering users  33–42
starting up with  103–105

S

saving documents  93
screen captures, allowing users to make

31, 41
scripts, AppleScript  71
Secured Items folder  104, 106
security features, setting  2, 30–32
selecting multiple items  24, 27, 36, 39
Set Application Preferences screen  57
setting up At Ease  11–47

administrator password  17–18
advanced procedures  49–65
duplicating an existing user’s

privileges  45
on-screen instructions  13–17
registering At Ease panels users

20–32
registering owner  19–20
registering regular Finder users  42–44
registering restricted Finder users

33–42
removing users  46

shared disks
creating buttons for  54–55
ejecting  92
setting user access to  26, 38, 54–55

shared folder, aliases for  68
Shift key, selecting multiple items  24,

27, 36, 39
Shut Down command (Special menu)  93
shutting down the computer  93
“snapshots” (screen captures), allowing

users to make  31, 41
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sounds
adding/removing button sounds

59–63
attached to buttons  29
importing  60–61
recording  62
removing  63
turning on/off  92

speaker icon  60–63
Special menu  91–93
spoken button names feature  68

activating  29
startup disk  69
stationery pads, creating from documents

85–86
switching between panels  78
system requirements  5

T

Tab key, switching between panels  78
text-to-speech feature. See spoken button

names feature
Topics button (At Ease Setup Guide

access window)  15, 97, 98
troubleshooting  67–75
turning off At Ease  63
turning on At Ease  47
Turn Sound Off command (Special

menu)  92

U

unlocking documents  85–86
user folder, saving documents to  93
user greeting, changing  58–59
user panels  77

users
changing access privileges  32, 42, 

44, 46
duplicating an existing user’s

privileges  45
password  21–22, 33–34, 43
registering (At Ease panels)  20–32
registering (regular Finder)  42–44
registering (restricted Finder)  33–42
removing  46
setting access to items  23–32, 35–42
setting security features for  30–32
working environments  20, 21, 33

V

View menu  90–91
virtual memory, and the spoken button

names feature  29, 68

W, X, Y

Welcome screen  58, 75–76, 103
working environments  20

specifying for users  21

Z

zoom box (At Ease panels)  14
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